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Throughout this policy the words "we", "us" and "our", or “Sienci Labs” will be used to refer to Sienci Labs Inc. herein and
“Mill One” or “machine” will refer to Sienci Labs’ Sienci Mill One product. Additionally, the words "you", "your", “user”,
and “operator” will refer to the original purchaser/customer, user, or viewer of any of the products or media provided by

or through Sienci Labs.

Machine Disclaimer

The listed “Safety Warnings and Guidelines” outline the necessary precautions that should be taken any time the
machine is operated. By assembling our provided kit, the product user takes on all the associated liability pertaining to
the operation and maintenance of the Mill One. Sienci Labs will not be held responsible for any damages to property or
injury incurred on the operator or bystanders if any alterations are made to the design or assembly of our machine.
Although care is taken to ensure the accuracy of information made available on our website (www.Sienci.com) and other
forms of media, Sienci Labs will not be held liable for any inaccuracies, errors, or inconsistencies in website content, the
content of files linked to by our website, references made to external websites herein, and/or other information
produced by Sienci Labs. The information which has been made available will not be applicable to all situations and is
subject to change without notice so it should not substitute for the discretion of the user. Variability in machine accuracy
and performance may occur due to improper machine assembly by the user, as such, Sienci Labs takes on no
responsibility for variation between claimed machine specifications and the performance of the user’s machine from
improper assembly.

Safety Warnings and Guidelines

1. Besure to carefully follow provided machine assembly instructions before machine use to ensure operator
safety.

2. Allwires must be appropriately positioned before beginning the operation of this machine. Cutting a “live” wire

may cause exposed metal parts of the routing/trimming tool to become electrified and shock the operator.

Ensure the machine is placed on a flat surface and in a well-ventilated space before operation.

Always wear eye protection during machine operation.

Always wear hearing protection during extended machine operation based on proximity to machine.

Materials may release chemicals that are toxic or unsafe to inhale when cut. Always check the Material Safety

Data Sheet (MSDS) of the material in question before cutting. Always cover exposed skin and wear appropriate

airway protection (e.g. dust mask/respirator) specific to the material used and its application.

7. Anyworkpiece must be appropriately secured before starting a cutting routine by clamps or other practical
securing method. Holding the material by hand or employing any any other unstable form of securing will lead to
unsafe loss of machine control.

8. Cutting bits used for the Mill One should be used at the discretion of the user. Bits are sharp and can crack and
break without notice so appropriate care should be taken by the user while manipulating and installing them.
Carefully check bits for cracks or damage before operating the machine and replace any cracked or unfit bits
immediately.

9. Carefully inspect any consumable material before use on the machine, any unforeseen inconsistency in material
hardness or material quality may cause damage to the machine.

10. Keep away from all moving parts during machine operation.

11. Before beginning a cutting job, ensure the router/trimmer runs properly. Immediately disable the tool if visible
vibration or wobble occurs. This might indicate a damaged tool or an improperly installed bit.

12. Make sure the bit is not contacting the workpiece before the router/trimmer tool is turned on.

13. Do not leave the machine running unattended, the machine should only be operated with the operator present.

14. Do not touch the cutting bit immediately after use. It may be hot and could burn the operator.

15. Use bits that are appropriate to the material and cutting speed used.
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LIST OF
PARTS

1x

2.5
Allen Keys

6 Phillips

F-AC
1x
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STEP 1

Lead Screw @ O
Nut Holding = ® ¢
Assembly P-NH AN M3-8 2.5
3x 3x 12x Allen
**If you have purchased the anti-backlash nut kit for your Sienci Mill One,
then the lead screw assembly above will be replaced by the anti-backlash SIENCI LABS

nut assembly. Follow the instructions provided on the bag of the kit instead.
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Chris
Typewriter
**If you have purchased the anti-backlash nut kit for your Sienci Mill One,

    then the lead screw assembly above will be replaced by the anti-backlash

    nut assembly. Follow the instructions provided on the bag of the kit instead.
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STEP 2

XZ Gantry
Assembly

G-XZ
1x

M5-25
2x

M5-N
2Xx

Allen
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STEP 3

Y Gantry
Assembly e
GY M5-25 M5-N 4
1x 2x 2x Allen
@'
uy ng
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STEP 4

XZ Gantry S @ Q
|
Assembly
VB M5-25 M5-W M5-N M5-NE 4 8mm
4x 4x 4x 2x 2% Allen Wrench
|
|
|
|
|
|
|
| |
| S
Match the eccentric nuts (M5-NE) |
to the larger holes, and the regular @
nuts (M5-N) to the smaller holes
SIENCI LABS
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STEP 5
XZ Gantry & @ ® Q
Assembly
VB M5-25 M5-W M5-N M5-NE 4 8mm
4x 4x 4x 2x 2% Allen Wrench

Match the eccentric nuts (M5-NE) to the larger
holes, and the regular nuts (M5-N) to the smaller
holes
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STEP 6

Y Gantry
Assembly

‘)

VB
4x

M5-25
4x

M5-W
4x

M5-N
2x

&

M5-NE
2x

o A

4 8mm
Allen Wrench

Match the eccentric nuts (M5-NE) to the larger
holes, and the regular nuts (M5-N) to the smaller
holes

H
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STEP 7

Mounting the

Motors to the & ol
Rails M3-8 25
3x 3x 12x Allen

Make sure that the motor connector is facing
downwards
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STEP 8

Mounting the
Motors to the
Rails

©
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STEP 9

Attaching
Z-Lead Screw
to XZ Gantry L5-200 sc )

1x 1x Allen

Make sure to push coupler all the way onto lead
screw before tightening
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STEP 10

Attaching the o Q

Z-Rail to the XZ
Gantry

2 8mm
Allen Wrench

Rotate the eccentric nuts (M5-NE)
until gantry slides onto the rail easily

Make sure to push coupler all the way onto
motor shaft before tightening
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STEP 1

Attaching the

X-Lead screw to d I

the XZ Gantry : 2 8mm
and Calibration 2% 1x Allen Wrench

Rotate the eccentric nuts (M5-NE) to
tighten the grip of the wheels on the rail.
Tighten until you can no longer rotate
the V Groove bearings (VB) with your
fingers.

Make sure to push coupler all the way onto lead
screw before tightening
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STEP 12

Attaching the o Q

X-Rail to the XZ

Gantry ) 8mm
Allen Wrench

Rotate the eccentric nuts (M5-NE)
until gantry slides onto the rail easily

Make sure to push coupler all the way onto
motor shaft before tightening
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STEP 13

Attaching the

Z-Rail to the XZ @" . Q

Gantry and M8-15 6 8mm
Calibration 1x 2% Allen Wrench

Rotate the eccentric nuts (M5-NE) to
tighten the grip of the wheels on the rail.
Tighten until you can no longer rotate
the V Groove bearings (VB) with your
fingers.
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Allen

1x

1x

STEP 15

Attaching Lead
ScrewtoY
Gantry

Make sure to push coupler all the way onto lead

screw before tightening
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STEP 15

Attaching the o Q

Y-Railtothe Y

Gantry ) 8mm
Allen Wrench

Rotate the eccentric nuts (M5-NE)
until gantry slides onto the rail easily

Make sure to push coupler all the way onto
motor shaft before tightening
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STEP 16

Attaching the
Y-Railtothe Y
Gantry

o &

6 8mm
Allen Wrench

Rotate the eccentric nuts (M5-NE) to
tighten the grip of the wheels on the rail.
Tighten until you can no longer rotate
the V Groove bearings (VB) with your
fingers.
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STEP 17

AttachingY 9 .

Gantry to

Frame F-B F-F M8-25 M8-N 6
1x 1x 4x 4x Allen
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STEP 18

Attaching XZ

Gantry to
Frame 6
1x 1x 4x 4x Allen
0
o
o
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STEP 19

Attaching the
Assemblies

@

V@
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STEP 20

Attaching @" o

Frame Brackets

Twist on bolts on all corners loosely,
then tighten on a flat surface
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STEP 21

Attaching @" .
Router Mount
M8-15 6
1 X 2 X A”en
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STEP 22

o | @ o

1x 1x 2x 2x Allen

P-RM router mount fits the Makita
RTO701 router without P-RB bushing,
bushing only required to mount
Ridgid R24012 router
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STEP 23

Attaching
Acrylic Shield
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STEP 24
Combining the
Arduino and
CNC Shield
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STEP 25

Attaching the
Header
Jumpers

E-HJ
6X
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E-C
3x

Motor Cables

STEP 26
Attaching

Make sure the black wire is oriented as depicted
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Stepper Driver

STEP 27
Attaching
Chips
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STEP 28

Tuning the +

Stepper Motor

Drivers Phillips

The stepper drivers should be tuned using the
) potentiometer on the front so that the flat
20 edge on the dial faces to the left; this gives
the stepper motors on the Mill One the right
amount of power to run effectively. If further
tuning is required, turning the flat either

counterclockwise or clockwise will increase
or decrease the motor power respectively.

&

Stepper driver potentiometers should never
be turned while the board is powered up
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Placing Boards
into Electronics

STEP 29
Holder
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E-J

1x

STEP 30

Attaching
DC Jack
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Phillips

STEP 31

Attaching

DC Jack

Ensure polarity is correct to avoid damage to

electronics
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Covering the

STEP 32
Enclosure
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STEP 33

Attaching
Electronics to
Motors
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STEP 34

Assembled
Mill One

y ) 2 < | "?’E,?'"’?T/
R
Nz ‘ @
\ >

Your Mill One is now fully assembled. Don’t plug in your power brick yet, simply

connect the USB cable to your computer and continue onto the next steps.

H
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INSTALLING
FIRMWARE

$GSIENCI LABS

PUT CNC ON YOUR DESKTOP

Open your favourite web browser and navigate to the Resources tab of our website.

GSIENCI LABS

Machine Assembly Software Resources Facebook Forum

Once on the Resources page, click on the Software Resources heading, this will take you to the Software
Resources page.

DESKTOP CNC MILLING
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G SIENCI LABS

SOFTWARE RESOURCES

Software:

GSIENCI LABS rus  mommims-sa0

Firmware Search site

nstructions on the

r % microstepping

with the atest nightly builds of

y bullds may have the potential to |

Under the Software heading, you should notice a link to the Firmware and on the Firmware page, you'll
want to click to download the “Grbl 1.1v with default settings for the Sienci Mill One” firmware.

Dovme vt 1 s Mt W

ARDUINO

0000

ARDUINO ¥

IhE + 3

You'll also want to download the latest Arduino IDE onto your computer. Select your operating system
to download the appropriate package.

-,
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= i ard

ARDUINO

ownload

0 00 0

with the

Arduine provides an open-source and easy-to
use programming tool, fo
ioedin

Arduing IDE [inte

Preparing boards...,
Warning: Use java 8
i .
= f
&) D), @
SOURCECODE

PREVIOUS RELEASES

Open the Arduino IDE once it’s insta

New N
Oy
Ogetrt Recent [
Sketchbook *
Examples 3
Clase EW
ARD|  Saw #s
Save As... Tus

Pape Setun 0P
Print ®p

0000

Program your hardy

uino

Ardulne provides an open-source and easy-1

use programming bool,
Arduing 1DE (In

If you are new to Arduino =

Warning: Use java B v

5

PREVIOUS RELEASES

Once open, navigate to File-> Open

uino.org

Wiielvi-) k

Cenuino

ARDUIND

lled

4

andiing ang

Skench,_jan23a | Arduino 1.8.1

SOURCECOOE

T 40 SINEE M MoniZBAM Andyles O M

CHANCELOG
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m < w =[E) m-  Bmoownicads $ il -
Firvorioas & arduino I GRBL v1.1 SLne Fiemwara  * [0 grbt . canfig B coskiap. B doskiop
= DonDenDoniD B8 ch34aog-ch3. driver-master * B UniversalGe _er 2.0 Nightty  » grolz eoalant_contr B groiuplosa --""I"!:'l._
= at | ORBL-v1 " et cont B grbiWrite_Bulldinto » ansPi
[ Desktop ol 5iills ue
53 Google Drive i
7 musie B e
B MMy Files
B Pietures [0 examples L4
% Docurnents : 4
© Downicads
Davices
Remate Oisc
|2 ssca 8
Shared
B intot_ce_Snu
Tags
MNew Folde Cancel

You should find a folder for the GRBL download in your downloads folder. Navigate through the
folders until you find grblUpload.ino, double-click it to openiit.

AN 0rg
ARDUINO
Download
L] prhilpiosd | Arduing 1.8.1
0000 aid
ut 1
og L
L au LLIC b 1 4
Arduino provides an open-source and easy-{ | -
use programming tool, for writing coce and
phaading It 1o your b e
Arduino IDE (Integrat
If you are new to Arduino i
all Arudif .

52 java B with the new Arduing |DE!

Warning:

SOURCECODE CHANCELOC

This is the code that needs to be uploaded to the Arduino.
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& Ardulno Fie Edit JEITIENN Tools  Help O3~ % ]
Verify/Cample =1 Ry
Upiaad ®U
Upload Using Programmer €30 owtinnd the angns Ao softwary
Export compiled Binary TES
Show Sketch Folder oK

ARDUINO

Add File...
DownToad

prbiUpinad | Arduing 18,1

0 0@¢eo

Robot Controd "
Raobat IR Remate
Arduino provides an open-source and easy:

use programming tool
i riaring T ko e Tachs &
Apiuie " Spacebrewiun
If you are new v Temboo e
art we have pre vit  Wire
tall Aruig E e

‘Adafreit Circalt Playground

Warning: Usa Java 8 with the new Arduino 108

Fmy

ey

l‘""‘_}l)

. "5

PREVIOUS RELEASES SOURCECO0E CHANGELOG

Robat Mator L o e
5D

T o) NI M MonTISAM Andylee O @ =

The last step to prepare for uploading the code is to include the Grbl library. Go to Sketch->
Install Library-> Add .zip Library then navigate back to your downloads folder.

0 £ n= E 2.+  [B bownloads &

Favarites € Arduino =9 GRBL ¥1.1 SL.ne Firmware »
5 DonDonDon3D 8 ch340g-ch3.. driver-master * [ UniversalGe..er 2.0 Nightly »
E5 Photos M GREL-v1 =
2| Desktop

5 Google Drive
J1 Music

E Al My Files

& Pictures

@ Documents

€ Downloads

Devices

@) Remote Disc

L] sace

Shared

13

B intel_ce_linux

Tags

Mew Folder

th Q
 grbl »
li grblzip
{
|
Cancel

Once again, open the Grbl folder then navigate through and double-click on the grbl.zip file.
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ARDUINO

arduine.org

Arduino provides an open-source and easy-t

use programming toal, for writing c

Arduino IDE

If you are new to Ar

Updates available for some of your librarie; %
=

SOURCECODE

CHANGELOG

The Arduino IDE should confirm that the Library was added and you will now be able to upload
the code to the Arduino.

& Arduino Fie Edn  Skeich DR Help [C} $

ARDUIND

Downlo

o 0@

Arduine provides an open-saurce and easy-4

use programming toaol, f

Arduino IDE (

Check in the Tools tab that you've selected your board to be the Arduino Uno.

- Rf

' Programmer; “AVRISP mki®
Burn Bootioader

i you are new to Arduino L

#uto Format BT

Mrchive Sketch

Fix Encoding & Reload

Sarfal Monitor T+ HEM

Serial Plotter ML

WiFI101 Firmware Updater

Board: “Arduinc/Genuino Uno®

Part: "fdevicu.vsbmodem 1421 [Arduina/Gemsina Lina]"

. - ’
Gat Board Info o Wil
L@ v Archsnol Feniana Ling
Arduing Duemilanowe or Diecimita
- T Arduino Nano

Ardusno/Genuine Mega or Mega 2660
i Ardising Mega ADK
I Arduin Leanardo

Arduino Leonardo ETH
1] ArduinaGemsEno Micro [
Ardusing Esplors
Arduing Mini
Arduine Etharnet
Ardisng Fio
Ardusing BT
LilyPad Arduing LISE
LilyPad Ardising
Arduino Pro or Pro Min
Ardiing NG or older
Arduing Robot Control
Arduing Robot Motor
Arduing Gemma
Adafrult Circuit Playground
Ardiuing: Yiin Mini

Boards Manager...

Ll v

SOURCECDOE

CHANGELOG

=) A B Mon122AM Andylee O @ =
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| & Ardulne File Eaht  sketch RN Hel & 4 o) R M Man1:29AM Andylee O @ =
Auto Format BT
Archive Sketch
Fix Encoding & Raload [l
Serial Monitor M

Sarial Plottar 3L
ARDUINO WiFi 101 Firmware Updater —

. Board: “Arduina{Genuing Uno® »

ANBEERE  Port: “/devicu usbmodsm 421 (Arduino/Genuing Unal® » - et
Get Board info [devjeu Bluetooth-Incoming-Part

. 5 " Jdavicu.BIGJAMBOXby awbone-SFRD
0 0 @ { Programmer; "AVRISP miil L Jodeney usbmodem 1421 (ArduineiGanuing Una)
Burn Bootloader
T — =

1

=
Arduine provides an open-source and easy-1 b
use programming tool, for w 3
plonding t ko
Arduino IDE {|
If you are new to Arduinog 5
mear
f Juin e

Warning: Use Java 8 w

)

-

Also check that the proper port is selected.

arduing.arg

ARDUINO

Down

0 000

Arduino provides an open-source and easy-1
use

rogramming tool,

Basanr

Warning: Lise lava 8 with the new

SOURCECODE CHANCEL DG

Then click Upload on the IDE to upload the code.
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arduing.crg

ARDUIND

Download
3k Ll
gebitip

}
vold B =
7 | AR E
1 Wimcal
Arduino provides an open-source and easy-t | I
use programming toal, for wiiting code a
ploading it t L peo
Arduino IDE
If you are new to Arduino | E*
T
B s

PREVIDUS AELEASES SOURCECODE CHANGELOC

The IDE should confirm that the code is done uploading.

& Arduino File Edil Skeich LRIl Help [l ) = 4 Gwn@l W Mon1E0AM Andylee O 0 =
Auto Format uT
Archive Sketeh
Fix Encoding & Reload § hrrius
Sarial Meiar RN
Serial Piofer oRL
ARDUINO WIFI101 Firmware Uipdater

tos - Board: “Arduina/Genuing Una* 13

Downloac pon: jdevieuusbmodem142 1 (ArduinoiGenvine Uno)® 3
Get Board Infa Ipénad | Ardising 1.8.1

o O @ { Programmer: "AVRIS? midl 13

Burn Boatioader

a1
n T 7, | AR
o TDE ¥ Bseniis

Arduine provides an open-source and easy-1 -

use programming tool,

uploading it t
Arduino IDE {In

PREVIOUS RELEASES SOURCECODE CHANCELOGC

To confirm that the code was implemented correctly, go to Tools then open up the Serial Monitor.
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ARDUINOD

yad
il soe Jdmcuiisbmodem 1427 [Ardul

|
0 0 © 0

Grol 1.1e ['%° for help]

Arduino IDE (Integat
If you are new to Af 2
a . ceepared B Autaseroll Wewline B uswobpd B

v T ¥ al T 3 Lkl 13 g [ b 4

Once you set your baud rate to 115200 you should see that the monitor shows the following
message, this means that the firmware has been uploaded correctly.

Congratulations!

Your Mill One should now be ready to go. In order to start using your machine you should start
becoming comfortable with a CAM software as well as find a program which will send the g-code
to your machine. For our software recommendations, you can navigate back to the Software
heading on the Resources page of our website. For additional resources, be sure to check out our
other hardware resources as well as request to join our user Facebook group where you can ask
guestions, find answers, and interact with the rest of the Sienci community.
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